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The FARO Laser Tracker X is a portable 3D measurement 
system which uses laser technology to measure large 
parts, tooling, and machinery.  In real time, it captures 
the 3D coordinates of a mirrored spherical probe.

The purpose of a Geomagic plugin is to integrate the col-
lection of point data into a Geomagic application, elimi-
nating the need to capture data and load it into the 
application in separate steps.

Plugins > FARO Tracker activates the interface 
in Geomagic Studio and Geomagic Qualify to the FARO Laser Tracker X. This 
menu item is an optional, separately installable feature. If FARO Tracker 
does not already appear on the Plugins menu, download the software from 
support.geomagic.com/downloads and install it according to instructions on 
the web site.

Turn on the FARO Laser Tracker X before activating the plugin. 
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Controls and Indicators
This section details the controls and indicators on the user interface of the 
plugin.

Recurring Controls and Indicators

The following controls appear on all of The Four Main Dialogs.

• Display Units group - specifies the units of measure on the object that 
will be scanned, such as inches or millimeters.
• Units dropdown (inches, millimeters, meters, feet, etc.) - specifies the 

units of measure.
• Tracker Controls group - specifies the units of measure on the object 

that will be scanned, such as inches or millimeters.

• Tracker Pad icon button - offers Tracker configuration options.

• Initialize button - runs the tracker initialization sequence.
• Home - points the tracker to the TMR of the active target.  This but-

ton is disabled when the motors are off.
• Turn Motors On/Off button - toggles the state of the motors.  It is 

disabled if the tracker has not been initialized.
• Turn Tracking On/Off button - toggles the tracking state.
• Set Backsight button - toggles the orientation of the tracker.  This 

button is disabled when the motors are off.
• Search Target ... button - search for a target.  It has a separate dia-

log that is used to configure and start the search.

The radius is the maximum radius that the tracker should search for a 
target at a given range.  If the "Use Estimated Range" check box is 
checked, an estimated range can be entered which the tracker will use 
for the search. The unit of measure for both values is based on the -
uLength parameter provided when the application is started.  If none 
is specified, meters is used. This button is disabled if the motors are 
off.
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• Highlight Beam button - The highlight beam button has the tracker 
move the beam in an expanding and contracting spiral so that the 
user can visually locate the beam. This button is disabled if the 
motors are off.

• Drive Beam ... button - activates a dialog that allows the user to 
drive the axis of the tracker to a given location using three different 
methods. This button is disabled if the motors are off.
• Visual Drive button - The user clicks on the control pad to start 

the axis moving.  Clicking to the right or left of the crosshair 
causes the azimuth axis to move to the right or left.  Clicking 
above or below the crosshair moves the zenith axis up or down.  
The azimuth and zenith locations update as the axis moves.

• Angular Drive button - allows the user to specify the azimuth and 
zenith angles (and optionally a distance) to the target.  The 
"Search…" button provides a convenient way for the user to search 
for a target once a move has been completed.

• Manual Drive button - allows the user to point the tracker by 
hand to a given azimuth and zenith. The user can toggle the 
motors on and off.  In addition, the "Search…" button provides a 
convenient way to search for the target once the tracker is pointed 
and the motors are on.
Document Version A October 1, 2005 page 3



Raindrop Geomagic, Inc. Geomagic FARO Tracker Plugin
• Set Distance Mode ... button - allows a user to choose how the 
tracker measures the range to the target (Interferometer Only, Inter-
ferometer Set By ADM, or ADM Only). If multiple modes of operation 
are not available for the tracker, the distance measure mode button is 
disabled.  Note that the "ADM Only" choice does not appear for 4000 
series trackers.

• Set Weather Configuration ... button - allows the user to configure 
the air pressure, air temperature, and humidity on the tracker. The 
tracker can be configured to read each value from a sensor, or values 
can be entered manually.

• Set Temperature Configuration ... button - configures alarm 
parameters for each of eight sensors that may be plugged into the 
Master Control Unit (MCU).

• Display Bubble Level ... button - activates an electronic level that 
can be used to adjust the tracker so that it is tilted no more than the 
recommended 1 degree before measuring the level plane. 

• Set Time ... button - allows setting the date and time in the MCU.
• Set Distance ... button - allows setting the distance to the target.
• Set IP Address ... button - If the user logged in with factory or 

administrative privileges, the IP address of the tracker can be 
changed to any valid IP address. Reboot the tracker after changing 
the address or mask.

• CompIT icon button - activates an application that performs 

compensation and interim test procedures.
• SelfComp button - performs self-calibration.
• Pointing button - runs the pointing compensation and interim test 

procedure.
• Level button - runs the level compensation and interim test proce-

dure.
• ADM IT button - runs the ADM compensation and interim test proce-

dure.
• Backsights button - checks backsight at any location the user 

chooses.
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• Customize button - changes settings for compensation and interim 
test.

• Settings... button - controls miscellaneous settings.
• Log button - shows historical data from past compensation and 

interim test runs.
• Exit button - saves settings and closes the CompIT application.

• Closure icon button - activates an application used to check clo-

sure at TMR location or against a specific point location. dR is the differ-
ence between the distance of TMR read from tracker and the distance 
measurement of the target if checking closure against TMR. If checking 
closure against a point, dR will show the difference between the dis-
tance measurement of a point and the distance value passed in by user. 

• Operational Checks icon button - There are two tabs behind 

the Operational Checks button, “General Page” and “Repeatability”.
• General Page tab - The SMR return power, PWM value and the 

external temperature sensor information are displayed to the user. 
For a 4xxx tracker laser intensity checks (PSD values, dark level val-
ues) can also be performed. The General page looks as shown below. 
The meaning of the symbols that appear next to each of the weather 
and temperature sensor fields is as follows. 
The lightning bolt implies automatic (i.e. the value is read from the 
tracker), while a yellow pencil indicates that the value is set manu-
ally. A red pencil with a strike across implies that the status of the 
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information is an error status (for external temperature sensors, it 
implies that the sensors are not plugged in). 

• Repeatability tab - lets the user test the static and dynamic repeat-
ability of the tracker at various locations in the work volume. Also the 
closure checks at various points in the work volume can be checked 
through this page. The Repeatability page looks as shown below for a 
FARO tracker (the data is in red color indicating that the beam is bro-
ken). 
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• Target Type dropdown (a list of target ball descriptions) - specifies the 
target-ball that is in use.

• Use Nest checkbox - specifies whether a nest is connected to the tar-
get ball. If so, the following fields are applicable.
• Nest Offset decimal field - specifies the length of the shaft on the 

nest tool.
• Nest Shank decimal field - specifies the width of the shaft on the 

nest tool.
• Scanning Options group - controls behavior of the tracker during data 

collection.
• Samples per Point integer field - specifies the number of laser sam-

ples that are averaged to yield the location of a single point. This set-
ting applies to all Data Collection Methods.

• Collection Technique group - specifies the conditions under which 
the Tracker collects each point.

• Single Point radio button - specifies that each press of the 

Enter key causes the collection of a single data point.

• Time radio button and Interval decimal field - The tracker 

collects a point at a periodic interval, given in fractions of a second.

• Distance radio button and Interval decimal field - The 

tracker collects a point when the traget ball has moved a distance 
from the previous point.

• Stabilized Laser radio button - The tracker collects a point 

when the target ball has been almost motionless (not moved more 
than Distance Tolerance) during a specified Stabilization Time 
period.
• Distance Tolerance decimal field - the distance element of 

“almost motionless”.
• Stabilization Time(s) decimal field - the time element of 

“almost motionless”.
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The Four Main Dialogs

HARDWARE ALIGNMENT DIALOG

• Hardware Alignment icon button - Alignment is the synchro-

nization of the coordinate system of a reference object with the coordi-
nate system of the tracker and test object, such that the coordinates of 
incoming data points can be correctly compared to points on the refer-
ence object. This button activates controls and indicators for the align-
ment process. Every scan must be performed with respect to a known 
spatial orientation (also called a “coordinate system”, imprecisely called 
an “alignment”). The spatial orientation remains in effect on subseqeunt 
scans and the next time Geomagic Studio or Qualify is started.
• Display Units group - see Recurring Controls and Indicators on page 

2.
• Tracker Controls group - see Recurring Controls and Indicators on 

page 2.
Define an orientation by one of the following methods.

• Last Test Model Alignment button (selectable only when an 

object has been designated in the Model Manager as the Test object, or 
when a Feature/Datum object is present in the Model Manager) - speci-
fies that the spatial orientation is based on the scheme of an existing 
object. In Geomagic Qualify, use the orientation of the currently desig-
nated Test object. If no Test object exists, use the spatial orientation of 
the Feature/Datum object. If this is Geomagic Studio, use the spatial 
orientation of the Feature/Datum object. (See Example of “Last Test 
Model Alignment” with Geomagic Qualify on page 27.)

Hardware 
Alignment 
Dialog

Features And 
Datums Dia-
log

Scanning 
Dialog

Real-Time 3D 
Comparison 
Dialog
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• Load Transform button - allows the user to select a .tfm or .xal 

file that defines a spatial orientation.

• Use CSYS button - sets the spatial orientation (also called Coor-

dinate SYStem) to the tracker default, where the laser “eye” is the ori-
gin.

• 3-2-1 Alignment button - Allows the user to establish spatial 

orientation by defining the position of the X, Y, and Z planes. See 3-2-1 
Alignment on page 13.

• “Move Device” Wizard is a specialized procedure for aligning 

the multiple  scans of an object that is larger than the reach of the 
tracker. It involves the probing of reference points, moving the object 
or the tracker itself, and probing of the same reference points to re-
establish bearings. This section presents two buttons that are the entry 
point to the “Move Device” feature. See Move Device on page 20.

• Transformation Matrix - is a representation of the transformation 
that will be applied to all incoming data. This is not in human-readable 
form, but a change in the values confirms that an alignment technique 
has been successful. 

• Show Coords button - presents the current XYZ coordinates of the 
tracker ball.

FEATURES AND DATUMS DIALOG

• Features And Datums icon button - allows the creation of 

datums and features. For detailed procedures, see Datum and Feature 
Creation on page 16.
• Display Units group - see Recurring Controls and Indicators on page 

2.
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• Tracker Controls group - see Recurring Controls and Indicators on 
page 2.

• Object Name field and Reset button - indicates the name of the 
object that will be stored in the Geomagic Model Manager. Names are of 
the form Scan 1, Scan 2, Scan 3, .... Reset restores the numeric part 
to 1.

• Datum/Feature Type group - specifies the kind of datum or feature 
that will be defined by use of the tracker ball. A datum or feature can 
be defined even if no scan data exists yet. If no scan data yet exists, an 
“empty” point object called Datums/Features is created in the Model 
Manager and the new datum and feature sub-objects are stored under 
it. 
The datum types are: plane, axis, point, and point target.
The feature types are circle, slot, rectangle, and line.
For complete definitions, see the online help in the Geomagic product at 
Tools > Datums > Create Datums.

• Input Method group - (applicable with some of the Datum types) 
specifies the method by which you will use the probe to define the 
datum. A datum can be defined even if no scan data exists yet. If no 
scan data yet exists, an “empty” point object called Datums/Features is 
created in the Model Manager and the new datum and feature sub-
objects are stored under it. The Input Methods are:
• Cylinder (for the axis datum) - the user is instructed to click six or 

more points on the surface of the cylinder
• Cone (for the axis datum) - the user is instructed to click six or more 

points on the surface of the cone
• Surface Point (for the point datum and point target datum) - the 

user is instructed to probe three points to define a plane, then one 
point on the surface of that plane.

• Best Fit Centroid (for the point datum and point target datum) - the 
user is instructed to select three or more points to define a plane. The 
defined point is at the best-fit center of this collection.

• Sphere (for the point datum) - the user is instructed to select four or 
more points on the sphere surface. The defined point is at the center 
of this sphere.

• Single Point (for the point datum) - the user is instructed to probe 
one point. The defined point is at the center of the probe.

• Show Instructions checkbox - specifies whether the user interface 
presents a sentence explaining how to define the datum or feature 
given the Datum/Feature Type and the Method Input that is chosen.
• Instructions (if requested by the Show Instructions checkbox) 

- presents a sentence explaining how to define the datum or fea-
ture given the Datum/Feature Type and the Method Input that is 
chosen.
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• Show Information checkbox - specifies whether the user interface 
presents the following details about the just-created datum or fea-
ture:
• Feature Information group - The following fields are populated 

when appropriate for the datum or feature that is being detailed:
• Feature - the name of this feature.
• Radius - the radius of this feature, if applicable.
• Length - the length of this feature, if applicable.
• Width - the width of this feature, if applicable.
• Center X - the center of this feature on the X axis.
• Center Y - the center of this feature on the Y axis.
• Center Z - the center of this feature on the Z axis.

SCANNING DIALOG

• Scanning icon button - Scanning is the process of collecting 

data points from a physical part.
• Display Units group - see Recurring Controls and Indicators on page 

2.
• Tracker Controls group - see Recurring Controls and Indicators on 

page 2.
• Object Name field and Reset button - indicates the name of the 

object that will be stored in the Geomagic Model Manager. Names are of 
the form Scan 1, Scan 2, Scan 3, .... Reset restores the numeric part 
to 1.

• Start Capture icon button - begins the data capture process.

• Data Options - affect the appearance of collected data after the plugin 
is closed.
• Merge Scan Passes checkbox - specifies whether to perform a point 

merge on all individual scan passes created during the current ses-
sion of the plugin.  The result will be one point object in the Model 
Manager.

• Sampling checkbox - specifies whether to perform uniform sampling 
(a reduction of point density) on the resulting point cloud at the end 
of a scan pass.
• Spacing - specifies the spacing parameter used by the Uniform 

Sample operation.
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REAL-TIME 3D COMPARISON DIALOG

• Real-Time 3D Comparison icon button (visible in Geomagic 

Qualify, not Geomagic Studio) - Real-Time 3D Comparison is a scanning 
method during which the deviations between scanned points and a refer-
ence object are graphically illustrated in real time. This button activates 
the laser scanner in a mode that performs real-time 3D comparison of the 
scanned object to a reference object.
• Scanner Controls group - is identical to the “Scanner Controls 

group” under the Laser Capture icon button, detailed on 11.
• Initialize button - initializes the comparison process by creating an 

empty Result object in the Geomagic Model Manager.

• Start Compare icon button - begins the data comparison pro-

cess by passing control to the scanning device.
• Objects group - 

• Reference - indicates the name of the object in the Geomagic Model 
Manager that is designated as the Reference object.

• Scan - indicates that the test object is the “New Object” that is being 
scanned.

• Max. Deviation field - indicates the greatest difference between corre-
sponding reference and test points to allow in the test data. Points 
beyond this deviation are not included in the test data set.

• Display group - controls various aspects of the graphical display:
• Test Object checkbox - specifies whether to display the raw test 

data points during the data capture process.
• Color radio buttons - specifies the one attribute that will be colored in 

the Viewing Area:
• Color Reference - color will appear on the reference object.
• Color Test Points - color will appear on test points.
• Color Deviations - color will appear on whisker lines that extend 

between test points and the reference object.
• Edit Spectrum checkbox - allows modification of the color coding 

scheme of the deviation map in the Viewing Area.
• Statistics checkbox - specifies whether to include the following indica-

tors:
• Maximum Distances - indicates the maximum distance between 

any two corresponding points on the test and reference objects.
• Average Distances - indicates the average deviation between cor-

responding points on the test and reference objects.
• Standard Deviation - indicates the standard deviation between cor-

responding points on the test and reference objects.
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3-2-1 Alignment
This is a sub-procedure referenced by the Alignment section under Hardware 
Alignment Dialog on page 8.

This describes “3-2-1 Alignment” -- how to specify an object’s coordinate sys-
tem by defining the position of three orthogonal planes. The origin of the 
object’s coordinate system will be the point of intersection of the three 
planes.

Note: In the following procedure, start is equivalent to the Enter key on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the Enter key. stop is equivalent to the SpaceBar on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the SpaceBar.

Note: In the following procedure, a reference to the “probe” is the a refer-
ence to the tracking ball.

Note: This procedure is written for the case when Collection Technique is 
Single Point. When the collection technique is Time, Distance, or Stabilized 
Laser, data will be collected automatically and continuously in Steps 4 and 6. 
Automatic and continuous collection promotes scanning accuracy. Because 

The OK and Cancel buttons described here apply to all of The Four Main 
Dialogs.

• OK button - 
• For the Hardware Alignment function - saves the currently config-

ured alignment. The same alignment will be in effect the next time 
this plugin is started.

• For the Features And Datums function - saves datums and features 
into the Model Manager in an “empty” point object called Datums/
Features, or, if data was collected with the Laser function, as datum 
and feature sub-objects.

• For the Scanning function - performs any incomplete shading and 
saves scanned data into the Model Manager.

• For the Real-Time 3D Comparison function (Qualify only) - saves 
scanned data into the Model Manager as a point object named the 
same as the reference object, designates the point object as the test 
object, and creates a Result object in the Model Manager that indi-
cates differences between the test and reference objects.

• Cancel button - cancels all un-OK’d processing in the Hardware 
Alignment, Features And Datums, Scanning, and Real-Time 3D 
Comparison functional areas.
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collection will be automatic, you will not need to press start a second or third 
time in Step 4, and will you will not have to press start for a second time in 
Step 6. You will, however, press stop after three or more points are collected 
in Step 4, after two or more points are collected in Step 6, and after one or 
more points are collected in Step 8. You will know that a point has been col-
lected automatically, and thus you will know when it’s OK to press stop, 
when you see a flash of the red light on the tracker.

1. Click the large Alignment icon, then the 3-2-1 Alignment 

icon.
Recall that:
The plane orthogonal to the X axis is the YZ plane.
The plane orthogonal to the Y axis is the XZ plane.
The plane orthogonal to the Z axis is the XY plane.
The letter on each of the following icons represents the axis to which a 
plane is orthogonal. The sign on each icon represents a side of the plane. 

          

2. If the purpose of this alignment is to synchronize the coordinates a test 
part with a CAD object, look at the CAD object and ascertain the position 
of the X, Y, and Z axes (the YZ, XZ, and XY planes) with respect to the 
CAD object. (Note that a CAD object’s coordinate system always uses the 
right-hand rule).

3. Based on information ascertained in the previous step, perform any two 
of the following three actions:
• Click the +X icon or the -X icon.

(+X means that “above” YZ is the positive side of YZ.
-X means that “above” YZ is the negative side of YZ.)

• Click the +Y icon or the -Y icon.
(+Y means that “above” XZ is the positive side of XZ.
-Y means that “above” XZ is the negative side of XZ.)

• Click the +Z icon or the -Z icon.
(+Z means that “above” XY is the positive side of XY.
-Z means that “above” XY is the negative side of XY.)

The first button you press is designated as Plane 1.
The second button you press is designated as Plane 2.
Adhering to the right-hand rule, the software automatically selects a third 
button (either the + or - variant of the plane you didn’t pick), and desig-
nates it as Plane 3. The sign that the software picks is always the sign of 
Plane 1 times the sign of Plane 2. (+ * + = +) ; (+ * - = -) ; (- * - = +)
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4. On the physical object, position the probe on a point that lies in Plane 1, 
then click the start button. Position the probe on a second point that lies 
in Plane 1, then click the start button. Position the probe on a third point 
that lies in Plane 1, then click the start button.
You have just defined the position of Plane 1.

5. Pull the probe out and away from Plane 1, then click the stop button.
If Plane 1 was designated in Step 3 by a + icon, you have established 
the + side of Plane 1.
If Plane 1 was designated in Step 3 by a - icon, you have established the 
- side of Plane 1.

6. On the physical object, position the probe on a point that lies in Plane 2, 
then click the start button. Position the probe on a second point that lies 
in Plane 2, then click the start button. There is no need to select a third 
point on Plane 2.
You have just defined the position of Plane 2.

7. Pull the probe out and away from Plane 2, then click the stop button.
If Plane 2 was designated in Step 3 by a + icon, you have established 
the + side of Plane 2.
If Plane 2 was designated in Step 3 by a - icon, you have established the 
- side of Plane 2.

8. On the physical object, position the probe on a point that lies in Plane 3, 
then click the start button. There is no need to select a second or third 
point on Plane 3. 

9. Pull the probe out and away from Plane 3, then click the stop button.
Based on the right-hand rule, the software already knew the + and - side 
of Plane 3, but this was necessary to complete the process.

10. The current coordinates of the probe appear in a coordinate indicator box. 
Move the indicator box by dragging it to any location of the screen, or 
click the stop button to close the indicator. Click Show Coordinates to 
re-display the coordinate indicator box.

11. Hover the probe above the YZ plane and verify that the X coordinate in 
the indicator is appropriately positive or negative.
Hover the probe above the XZ plane and verify that the Y coordinate in 
the indicator is appropriately positive or negative.
Hover the probe above the XY plane and verify that the Z coordinate in 
the indicator is appropriately positive or negative.

12. Coordinate system definition is complete. To un-do the coordinate sys-
tem, click Reset and go to Step 2.

Detailed Example

To specify the YZ plane (with a total of four points), then the XZ plane (with a 
total of three points), then the XY plane (with two points): Designate Plane 1 
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by clicking the +X icon, then designate Plane 2 by clicking the +Y icon. The 
software automatically designates Plane 3 as +Z. Make nine clicks, some 
start and some stop, according to the illustration below.

Datum and Feature Creation
Datums and features can be created by use of this FARO scanner plugin soft-
ware, or by the use of tools that are native to the Geomagic products. In the-
ory, datums or features can be identified more precisely by touching the 
original object and by use of the FARO plugin. Depending on the accuracy of 
the scan and the user’s experience, however, it may be advantageous to cre-
ate datums and features using the native Geomagic tools.To create datums 
and features using the FARO scanner software:

Note: This procedure is written for the case when Collection Technique is 
Single Point.

1. Click the Features And Datums icon. 

2. Verify that the Target Type is set correctly.
3. Click the icon of a datum type or feature type to be created.
4. Check (or uncheck) the Show Instructions box for guidance on how to 

create each datum or feature type. Instructions also appear below. A 
summary of the instructions is:
• Click the start button to define points.
• Click the stop button to define offset directions and go on to the next 

step. 
• When you have finished creating all datums or features of a given type, 

click the stop button again.

12

3

4

5

6

7

8

9

+X +Y

+Z

YZ plane XZ
 pla

ne

Denotes clicking the GREEN button on the Faro Arm

Denotes clicking the RED button on the Faro Arm

XY plane
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Note: In the following procedure, start is equivalent to the Enter key on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the Enter key. stop is equivalent to the SpaceBar on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the SpaceBar.

Note: When defining several features on the same plane, you do not need to 
define that plane for each feature. To recall the last defined plane, click on 
the plane with a single start click followed by a stop click.

Creating a DATUM PLANE

1. Click the datum Plane icon.
2. Define a plane by clicking start on 3 or more points on the surface of the 

object.  
3. Define the offset direction by clicking stop on a single point above the 

plane.
4. Repeat steps 2 and 3 to define other planes, or click stop to return to the 

dialog.  

Creating a DATUM AXIS Using CYLINDER Method

1. Click the datum Axis icon.

2. Click the Cylinder method icon. 

3. Define a cylinder by clicking start on 6 or more points on the surface of 
the object.  

4. Define the axial direction by clicking stop on a single point inside or out-
side the cylinder.

5. Repeat steps 3 and 4 to define other axes, or click stop to return to the 
dialog.  

Creating a DATUM AXIS Using CONE method:

1. Click the datum Axis icon.  

2. Click the Cone method icon.  

3. Define a cone by clicking start on 6 or more points on the surface of the 
object.

4. Define the axial direction by clicking stop on a single point inside or out-
side the cone.

5. Repeat steps 3 and 4 to define other axes, or click stop to return to the 
dialog.  
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Creating a DATUM POINT Using SPHERE Method

1. Click the datum Point icon.

2. Click the Sphere method icon.

3. Define a sphere by clicking start on 4 or more points on the surface of 
the object.

4. Click stop on a single point inside or outside of the sphere.
5. Repeat steps 3 and 4 to define other points, or click stop to return to the 

dialog.  

Creating a DATUM POINT or DATUM POINT TARGET Using CENTROID 
Method

1. Click the Datum Point icon.  or the Datum Point Target icon .

2. Click the Centroid method icon.  

3. Click start on 3 or more close points on the surface of the object.
4. Define the offset direction by clicking stop on a single point above the 

group of points.
5. Repeat steps 3 and 4 to define other points, or click stop to return to the 

dialog.  

Creating a DATUM POINT or DATUM POINT TARGET Using SURFACE 
POINT Method

1. Click the Datum Point icon.  or the Datum Point Target icon .

2. Click the Surface method icon.  

3. Define a plane by clicking start on 3 or more  points on the surface of the 
object.

4. Define the offset direction by clicking stop on a single point above the 
plane.

5. Click start on a single point on the surface.
6. Click stop to complete the process.
7. Repeat steps 3 through 6 to define other points, or click stop to return to 

the dialog.
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Creating a DATUM POINT Using SINGLE POINT Method

1. Click the Datum Point icon. .

2. Click the Single Point method icon.  

3. Click start on a single point.
4. Click stop to complete the process.
5. Repeat steps 3 and 4 to define other points, or click stop to return to the 

dialog.  

Creating a FEATURE CIRCLE

1. Click the feature Circle icon.

2. Define a plane by clicking start on 3 or more points on the surface of the 
object.

3. Define the offset direction  by clicking stop on a single point above the 
plane.

4. Click start on 3 or more points on the cylindrical wall perpendicular to the 
plane.

5. Define the offset direction by clicking stop on a single point inside the cir-
cle (to make a hole) or outside the circle (to make a protrusion).

6. Repeat steps 2 through 5 to define other circles, or click stop to return to 
the dialog.  

Creating a FEATURE SLOT

1. Click the feature Slot icon.

2. Define a plane by clicking start on 3 or more points on the surface of the 
object using the start button.  

3. Define the offset direction by clicking stop on a single point above the 
plane.

4. Click start on 3 or more points on the cylindrical wall of one end of the 
slot perpendicular to the plane.

5. Define the offset direction by clicking stop on a single point inside the 
slot (to make a hole) or outside the slot (to make a protrusion).

6. Repeat steps 4 and 5 to define the opposite end of the slot.
7. Repeat steps 2 through 6 to define other slots, or click stop to return to 

the dialog.  

Creating a FEATURE RECTANGLE

1. Click the feature Rectangle icon.
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2. Define a plane by clicking start on on 3 or more points on the surface of 
the object using the start button.  

3. Define the offset direction by clicking stop on a single point above the 
plane.

4. Click start on 2 or more points on one of the rectangular walls perpendic-
ular to the plane. 

5. Define the offset direction by clicking stop on a single point away from 
the rectangle wall.

6. Repeat steps 4 and 5 for the remaining three walls, working in a counter-
clockwise order.

7. Repeat steps 2 through 6 to define other rectangles, or click stop to 
return to the dialog.

Creating a FEATURE LINE

1. Click the feature Line icon (for the intersection of two planes)

2. Click start on 3 or more points on the surface of the object.  
3. Define the offset direction by clicking stop on a single point above the 

plane.
4. Click start on 2 or more points on a rectangular wall perpendicular to the 

plane.
5. Define the offset direction by clicking stop on a single point away from 

the wall.
6. Repeat steps 2 through 5  to define other lines, or click stop to return to 

the dialog.

Move Device
“Move Device” is a specialized procedure for aligning the multiple scans of 
objects that must be scanned from more than one point of view of the 
tracker. It involves the collection of reference points, moving the object or the 
tracker itself, and re-collection of the same reference points to re-establish 
bearings.

The following summary describes a process of scanning, moving the tracker 
because the object is large, and continuing with the scan.

Note: In the following procedures, a reference to the “probe” is the a refer-
ence to the tracking ball.

1. Scan part of an object.
2. If “Move Device” is not necessary, save the scan by pressing OK. 

If “Move Device” is necessary (because a physical constraint did not allow 
a complete scan), press the Alignment icon button.
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3. Press the Move Device Wizard button.
4. In the Move Device Wizard, click Begin.
5. On the Reference Point Collection Panel, use the probe to identify four to 

seven reference points on the physical object, each by one of four meth-
ods. On paper, write the name of each point, its location and identification 
method. Then click Next.

6. In response to a prompt, move the physical part or the tracker itself, then 
click OK.

7. On the Target Point Collection Panel, use the probe to re-identify the 
named reference points. As a result, the software can recalculate the ori-
entation of the tracker with respect to the physical object. The next scan 
will be a continuation of the previous scan. Press Next. 

8. On the Correspondence Report Panel, the software displays the precision 
to which it was able to associate the target points to the reference points. 
Eliminate any associations that are unacceptable, then press Done to 
specify that reference points and target points are sufficiently “con-
nected.” Go to Step 1 to scan more of the same physical object.

The detailed process is:

1. Press the Scanning icon button, then Start Scan. Scan as much of the 
physical object as space or the length of the arm allows.

2. If “Move Device” is not necessary, save the scan by pressing OK.
If “Move Device” is necessary (because a physical constraint prevented a 
complete scan), press the Alignment icon button.

3. Press the Move Device Wizard button. The Move Device Wizard group 
appears on the dialog.

4. This is the “Move Device” Home Panel. The buttons are:
• Begin button - begins a new “Move Device” process. Go to the Refer-

ence Point Collection Panel in Step 5.
• Resume button -  returns  to the panel on which you previously 

pressed Exit and saved the state of the “Move Device” process: the 
Reference Point Collection Panel in Step 5, the Target Point Collection 
Panel in Step 7, or the Correspondence Report Panel in Step 8.    

“Move Device” Home Panel
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5. On the Reference Point Collection Panel, use the probe to identify four to 
eight reference points on the physical object, each by one of three meth-
ods described below, or click Previous Targets to re-use the set of tar-
gets from a previous “move”. On paper, write the name of each point, its 
location, and collection method. Then click Next.

•  Reference Point Collection Methods:

• Single Point - You will touch the probe ball to a single point on 

the physcial object. For precision, the single point should be in a tight 
corner such as an inverted cone or hole whose diameter is smaller 
than the probe ball.

• Sphere Center - You will touch the surface of a sphere, either 

on the inside or outside, then a point in space to specify inside or out-
side. The defined point will be the center of the sphere.

• Circle Center - You will touch three or more points to define a 

plane, then several points on the inside or outside of a cylinder. The 
defined reference point will be the intersection of the plane and the 
axis of the cylinder.

Reference Point Collection Panel
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• Previous Targets - You will replicate the same set of target 

points that were used in the previous “move”. Use this method when 
the same points will still be within reach of the probe after the tracker 
or part is moved.

• Show Instructions checkbox - specifies whether to display instruc-
tions on how to collect center points.
• Instructions - the instructions, if requested.

• Reference Points section
• List of Points - lists the collected reference points by name. Each 

name is based on the method by which it was collected, such as Sin-
gle Point 1, Circle Center 1, Circle Center 2, and Sphere Center 1.

• Up and Down button - changes the order in which the reference 
points must be re-collected on the Target Point Collection Panel at 
step 7.

• Delete button - deletes the highlighted reference point from the list.
• Exit button - stops the reference point collection process, and returns 

to the “Move Device” Home Panel in Step 4. The prompt is “Save Cur-
rent State?” The choices are:
• Yes - saves the state of the “Move Device” process (in an un-named 

temporary location), returns to the “Move Device” Home Panel. The 
Resume button on the “Move Device” Home Panel will bring you 
back to this Reference Point Collection panel.

• No - returns to the “Move Device” Home Panel without saving the 
state of this process. On the “Move Device” Home Panel, the Resume 
button will be inactive.

• Cancel - returns to this Reference Point Collection panel, as if Exit 
had not been pressed.

• Next button - Reference points have been collected, so the scanning 
device or the part can be moved. You will be prompted to move the 
device or the test part. Go to Step 6.  

6. This is the Prompt to Move Device or Part. Move the tracker or the physi-
cal part, click OK, then go to the Target Point Collection Panel in Step 7.    

7. On the Target Point Collection Panel, use the probe to re-identify the 
named reference points. When the wizard prompts for the re-identifica-
tion of a particular reference point, use the written notes to re-create the 

Prompt to Move Device or Part
Document Version A October 1, 2005 page 23



Raindrop Geomagic, Inc. Geomagic FARO Tracker Plugin
reference point using the same method by which it was originally identi-
fied.  

The controls are:
• Show Instructions - specifies whether to display the Instructions 

box
• Instructions box - instructs the user how to collect the reference 

point.

Target Point Collection Panel
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• Define Targets button - press this to re-start the identification 

of targets (to re-start identifying the points that were previously identi-
fied as reference points). When this dialog first pops up, it is already in 
target collection mode, so use this button to re-start the process if you 
have pressed the stop button.

• Re-Define Last Target icon button - after pressing the stop 

button to stop collection, press this to delete the most recently col-
lected target point and to automatically re-start the identification of 
targets.

• Clear All Targets icon button - after pressing the stop button 

to stop collection, press this to delete all collected target points. To re-
start collection of target points, you must press the Define Targets 
button.

• Exit button - stops the target point collection process, and returns to 
the “Move Device” Home Panel in Step 4. The prompt is “Save Current 
State?” The choices are:
• Yes - saves the state of the “Move Device” process (in an un-named 

temporary location), returns to the “Move Device” Home Panel. The 
Resume button on the “Move Device” Home Panel will bring you 
back to this Target Point Collection panel.

• No - returns to the “Move Device” Home Panel without saving the 
state of this process. On the “Move Device” Home Panel, the Resume 
button will be inactive.

• Cancel - returns to this Target Point Collection panel, as if Exit had 
not been pressed.

• Next button - Press this when all reference points have been re-identi-
fied by use of the probe. Go to the Correspondence Report Panel in 
Step 8.

8. The Correspondence Report Panel displays the precision to which the 
software was able to associate the target points to the reference points. 
Eliminate any associations that are unacceptable, then press Done to 
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specify that reference points and target points are sufficiently “con-
nected.” Go to Step 1 to scan more of the same physical object. 

The controls and indicators are:
• Best Fit Result list - a list of the associations of target points to refer-

ence points.
• Delete button (applicable only when there are four or more point pairs 

in the Best Fit Result list) - allows any target/reference pair to be 
deleted from the result list. When a pair is deleted, the data is lost and 
the remaining paris are immediately re-evaluated.

• Datum Deviations list - displays the precision to which each of the 
reference/target pairs was associated. A pair with a large deviation was 
not scanned precisely enough, and may be hindering the best-fit more 
than it is helping, and is therefore a candidate for deletion.

• Done button - Press this to accept this set of reference points and 
associated target points (and modify the cumulative transformation 
matrix) and return to the FARO Scanning panel (in Step 1) for continu-
ation of the scan process.

Correspondence Report Panel
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Detailed Examples
This section contains examples that are referenced earlier in this document.

EXAMPLE OF “LAST TEST MODEL ALIGNMENT” WITH GEOMAGIC QUALIFY

This example demonstrates the use of Last Test Model Alignment in a CAI 
process with Geomagic Qualify. This assumes a working knowledge of Geo-
magic Qualify.

This procedure has two variants: the “Feature And Datum Technique” and the 
“Scanning Technique”.

1. Load a CAD object into the Model Manager and designate it as the refer-
ence object.

2. (Only for the Feature And Datum Technique) use Tools > Datums > 
Create Datums or Tools > Features > Create Features to create 
datums and features on the reference object.

3. Start the tracker plugin.
4. Perform one of the following:

• Feature And Datum Technique - Probe the corresponding datums and 
features on a test object that is resting in a test fixture (without laser 
scanning the test object). The datums and features become sub-
objects of a special special “blank” test object named “Features/
Datums” that records the position of the datums and features with 
respect to the test fixture.

• Scanning Technique - Scan a portion of the object, at least enough 
points that it could be aligned to the reference object using the best-fit 
alignment function of Geomagic Qualify.

5. Exit the plugin by clicking the OK button.
• Feature And Datum Technique - In the Model Manager, note the exist-

ence of the CAD object and the new test object called “Features/
Datums”. Note the existence of feature and datum sub-objects under 
the Features/Datums object.

• Scanning Technique - Continue to the next step.
6. Perform one of the following:

• Feature And Datum Technique - Use Tools > Alignment > Datum/
Features Alignment on the test and reference objects (which aligns 
the reference object with the special test object by aligning their com-
mon datums and features). 

• Scanning Technique - Use Tools > Alignment > Best Fit Alignment 
on the test and reference objects (which aligns the reference object 
with the test object by detecting the similarity of their surfaces.

The side effect of this process is that it creates an internal transformation 
matrix, which is a mapping of the spatial difference between the refer-
ence object and the test object.

7. Place a new test part in the test fixture.
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8. Start the tracker plugin again, and click the Hardware Alignment icon.

9. Click the Use Last Test Alignment button. This is a special align-
ment technique that uses the most recent transformation matrix to spec-
ify the spatial difference between the reference object and the test 
object. The net result is that scan data from the test part will be correctly 
aligned with the reference object. Next, you will scan the test part.

10. Click the large Scanning icon. Begin scanning. Scan data appears on the 
screen in alignment with the CAD reference object.

11. Exit the plugin by clicking the OK button. In the Model Manager, notice 
that the newly created scan object is now the test object.

12. To prepare to scan another test object, go to step 8. Every new test 
object will be aligned correctly.

EXAMPLE OF SCANNING

Note: This procedure is written for the case when Collection Technique is 
Single Point.

Note: In the following procedure, start is equivalent to the Enter key on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the Enter key. stop is equivalent to the SpaceBar on the 
keyboard or any key that has been programmed on a FARO Remote Control-
ler to represent the SpaceBar.

1. Click the Scanning icon.

2. In the Tracker Controls group, specify the type of tracker bball by pick-
ing a Target Type.

3. In the Scanning Options group, set the Collection Technique to Sin-
gle Point.

4. To perform a scan and thus create an object in the Geomagic Model Man-
ager:

• Click the Start Capture icon .

• Click the start button.
• Slide the tracker ball on the surface(s) of the object. Depending on the 

Collection Technique, a point will be collected when you press Enter, 
when the ball is stable, when the ball has traveled a distance, or at reg-
ular time intervals.

• Click the stop button to end scanning.
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EXAMPLE OF REAL-TIME 3D COMPARISON

This section describes the concepts of computer-aided inspection with Geo-
magic Qualify and any Geomagic scanner plugin.

1. The first step of a CAI process is to align the coordinate system of a refer-
ence object to the tracker so that collected data can be compared to the 
reference object in the same coordinate system. Use one of the alignment 
methods summaraized at Hardware Alignment on page 8.

2. Next, designate a CAD object as the reference object in the Geomagic 
Model Manager.

3. Click the Real-Time 3D Comparison icon button.
4. Click the Initialize button. The Start Capture icon button becomes 

active. 
5. Click the Start Capture icon button.
6. Use the the procedure under Example of Scanning on page 28.
7. If the physical part is larger than the reach of the tracker, go to Move 

Device on page 20, then return to this step.
8. If more scanning is necessary, go to Step 5.
9. When scanning is complete, click OK on the dialog. Scanned data is 

saved into the Geomagic Model Manager, the saved object is automati-
cally designated as the test object in the Model Manager, and the compar-
ison results are saved to a Result object in the Model Manager.
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